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This manual applies to OpenLAB CDS ChemStation Edition Software (version
C.01.03 and later until superseded) and Agilent 6100 Series LC/MS
instruments.

Where to find more information

Online Help Use online Help for in-depth information beyond what is shown
in this Quick Start Guide. Display online Help in any of the following ways:

¢ C(Click the Help button in the toolbar.
¢ Select Help Topics from the Help menu.
¢ C(Click the Help button on most dialog boxes to show task-specific help.

Agilent Technologies
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User Guides Besides this Quick Start Guide, the following guides are shipped
with your system and are also available in PDF format on the installation disk.

o Agilent 6100 Series Quadrupole LC/MS Systems Familiarization Guide
o Agtilent 6100 Series Quadrupole LC/MS Systems Concepts Guide

e Agtilent 6100 Series Quadrupole LC/MS Systems Installation Guide

o Agilent 6000 Series LC/MS Maintenance Guide

What's New in C.01.067

e 5 kDa/sec and 10 kDa/sec Fast Scan speeds on G6120B and G6130B with
step size of 0.2 Da. Multiple Fast Scan speeds, such as 5k Da/sec and 10k
Da/sec., are now supported for Data Acquisition.

e 5 kDa/sec, 8 kDa/sec, and 16 kDa/sec Ultrafast Scan speeds on G6150B
with step size of 0.2 Da. Multiple Ultrafast Scan speeds, such as 5 kDa/sec
and 8 kDa/sec or 8 kDa/sec, and 16 kDa/sec are now supported for Data
Acquisition.

What's New in C.01.03?

¢ Support for Windows 7 32-Bit and 64-Bit with Service Pack 1.
¢ Support for Fast Scan on G6120B.

¢ Support for Fast Polarity Switching on G6120B (hardware upgrade
required).

¢ Support for ESI with Agilent Jet Stream Technology on G6130B (hardware
upgrade required).

What's New in C.01.02?

¢ Support for Windows 7 32-Bit and 64-Bit.
¢ Support for 6100 Series LC/MS on OpenLAB CDS ChemStation Edition.

2 Agilent 6100 Series LC/MS System Quick Start Guide
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Configuration Diagrams

Configuration Diagrams

1100/1200/1260/1290 Series LC

Solvent hottles

Solvent cabinet

ET\/ Vacuum degasser
= I & ] ]
[—— [ = |
Pump \/-; o
] I ] ]
: l : = R Control module
| : (optional)
Autosampler B i S oSS o°
=N \Nﬂ/
[ [ & ] ]
[ | I =
Column
compartment
= | E ]
| I — [ [ = |
LC Detector
(DAD or VWD) S— =
= & ]
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Configuration Diagrams

LC Cabling

Remote cable ___—

CAN bus cable — ™

CAN bus cable \_/

Analog signal
to recorder

-

Il

|-

nonoonn |
Oonoooe

AC power

Shielded LAN cable
to network hub
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ChemStation Views

ChemStation Views

The LC/MS ChemStation software consists of several views. Click one of the
view buttons in the lower left corner of the screen, or from the View menu, to
change to a different view.

lﬁ] Method and Run Control

ﬂ Data Analysis

j Report Layout
% Verification (0Q/PV)
@ Diagnosis

C_L%' MSD Tune

Method and Run Control View Allows you to set up methods and adjust
instrument parameters to inject samples and acquire data one sample at a
time or in automated sequences. See the next page for more information.

Data Analysis View Allows you to perform various data evaluation tasks on
chromatograms and spectra, such as integration, quantitation, checking peak
purity, deconvolution, and report generation. See page 9 for more information.

Report Layout View Allows you to design custom report templates to use with
the data generated by your ChemStation. See page 12 for more information.

Verification (0Q/PV) View For use by Agilent service engineers to determine
if your system is operating in a predictable manner. This view is useful to
show Good Laboratory Practice (GLP) compliance, which some government
agencies can require. See page 14 for more information.

Diagnosis View Allows you to run tests to diagnose instrument problems and
access information on how to resolve these problems. The early maintenance
feedback (EMF) feature can notify you when it is time to perform system
maintenance before a problem occurs. See page 16 for more information.

MSD Tune View In this view, you can calibrate your LC/MS automatically. You
can also set MS parameters manually for specific types of molecules. See
page 17 for more information.

Agilent 6100 Series LC/MS System Quick Start Guide )
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ChemStation Views

Method and Run Control View

Tool Set Selection:
Sequence or Single
Sample

Method Sequence Top Toolbar
Status Bar

& LCMS Single Quad (online): Method and xunCom:alM I = o )
File RunControl Instrument Method Sequence Abort Help

{Raa] B Methods 1% oy

SULFA M SIM 11 ~|

nces U b [0 ic5 EAARLLS

1] LestRu

XN | (L) iethod: SULFAMS SIM 1M | &g Sequence: DEF_LC.S | (Sl P

| £ CChena2tethods

|| ntumet Conl [ Fun Gueue | Easy Seauenc | Eaey Seauence Sots]|

P "

Run -
Tt
e
Control ot
() DGCalas.M
{0 DGCaloQ1.M
) pGCalogz.M
) DGCaloQs.M
) DGCaloQdM
) DGCaloQs. M
—
System
Diagram 5o
——  [iW0CHECH
H - ) Infiniky-Checkout. M
File List S

. ®sop | SUTAMSSMLM

n
€ HPSampler 2. &

00 &

Q
100.0 0.0
0.000 mL/min

Data Analysis

netrument IS @ B on @)ort

n . Location Sample Name  Sample info. Datafile Data i, Injper Vel Done. . Total
] o
0 0

_jCA16Gs M=
=n

View
Selection

Online Plot &=

Message Line

Method Overview

clalals]

(v

Analysis
MS. FIA Disk Space

The user interface for Method and Run Control can be configured in two ways during

installation. See Agilent 6100 Series Single Quad LC/MS System Installation Guide for
information on installation and configuration.

If your instrument is configured with the Classic user interface, then see ChemStation
online Help and these manuals on the ChemStation disk:

» Agilent 6100 Series Single Quad LC/MS Systems Quick Start Guide
» Agilent 6100 Series Quadrupole LC/MS Systems Familiarization Guide
» Agilent 6100 Series Quadrupole LC/MS Systems Concepts Guide

Agilent 6100 Series LC/MS System Quick Start Guide
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ChemStation Views

Status and Run
Bars: Instrument

Right-click the Method icon to see the following commands:
Control Tab

Run Time Checklist, Method Information, Edit Entire Method, Method Audit
Trail, Print Method, and Help.

.ﬂ LCMS Single Quad (onling): Method and Run Control

File RunCentrol Instrument Method Sequence View Abort Help

E | Methods (%) Lad) [SLLFA b5 510 1.0 v|| Sequences |1 % [bEF_LC.5

a1][c2)[ErR=N) S e R
) BRI ) o suLPAMS 5 14 | g Squnce DEF LGS Gl
Method and Run Control

1 || Methad and Fun Contral

[=-Gaf CHChem32i1\Methods
) Batch.M

P maeeeoe s

Start
Sequence

Stop

Method
Sequence

System Diagram

Each icon of the system diagram represents one component or module of your
system. Click on an icon if you want to edit the method parameters or go to the
online Help for that particular component.

Injector Pump & Solvents

Column

Detectors

Ms

Idle [0

D)
ﬂ\;!@, =\ 2 Uil
eawa ¥eF

24.04°C 23. 17 °C

0.000 mL/mi
B B

0.00/ 0.00

Instrument
Idle
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ChemStation Views

Single Sample
Tool Set

Sequence
Tool Set

Flow Injection
Analysis (FIA)

This toolset allows you to work on methods and run an analysis for a single
sample. Move the cursor over a button to view a description of it.

- Click the Single Sample icon to display this toolset.

—p | S S

This toolset allows you to work on sequences and run automated analyses of
multiple samples. Move the cursor over a button to view a description of it.

Click the Sequence icon to display this toolset.

oy
L’|EJE|Q@&:

This toolset allows you to inject multiple samples directly into the detector,
which lets you bypass the chromatographic column. The results are sent to a
single data file. FIA can be used for method development or for applications
that do not require chromatography.

T T To enable FIA from the system diagram:
Uil - Click the FIA icon.
+ Select Edit FIA Series.
Mark the Enable FIA Series in Method option and edit the
FIA Table.

el

Method

Edit FIA Series...
il Help ' [ Enable FIA Series in Method

|—EIA Table

Agilent 6100 Series LC/MS System Quick Start Guide
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Data Analysis View

=

Instrument 1 (online): Data Analysis

File Method Sequence Graphics Integration Calibration  Report

Spectra Batch Analyst Wiew

§ signals L% L% | Methods Ly 'kb 3 [l DEF_LCM (fiom deta fie)
oE

Navigation Tools

Abort Help

=R

ChemStation Views

Cursor Tools

EEX

. - T § Use current method = W APl T R Not Ready | @
Flle I.lst —— ﬁ.S\ng\E £ Date Time Operator vial Data File Sample Name Method Name Man. Sample Info  Sample Am... | ISTD Amour &
5 3 anaLyst LB SR L (Vial53  MS3FRAGD | 100ng/ul [ESPSC3M | = sulfadugmix 0 ° =
-3 DEMO 1 81611999 1:49:49 FM | vial 1 |MSALIGN.D | | MISPURITY. M |~ |ioongidh 0 0
Lo oo T Ty oo - Feou — n T =
- {§ Single Runs
Tool SEt selecuon [ integration 2k Calibration |1 Signal [H}] Purity [ Spectum
gnied e Sl e e
signal View selection —— | ] Loaded Signals - §|@) =N 3 M Ui [ @ [l Alopap sugineiaapell v 1D, NoReference » | B ME
- - I DAD A, Sig=270,10 Reﬁoﬂ(*DEMU\MSSFRAG ) &
Display Graphics ] 8
Tools A A AA
DAD Signal ; 7 ; i : T
NSDT TIC, WS File (E\CHENGZVIIDATAMSDEMOWSIF RAG.D) AFI-ES, Fo3, Soan, Frag: 50, “low fragmantor
= g
H g ] g =
LC/MS Signal Y % A B 5 58§ £82 f\ fL § 3
g EE = S He o @md © S
o 1 2 3 4 5 s min |
o}

DADT, 3217 (32 & mALLBI) af MS3FRAG.D
DAD, 4431 (269 mAL, Apx) of MEZFRAG.D

Data | Methads |

% Method and Run Control
3 Repork Layout
% Verification (DQ/PVY)
@ Diagnosis
% MSD Tune
37‘5

S Instrument £ [ Ready

Message Line

T T T T T T T T T T T T T 1
200 225 260 278 300 325 200 225 260 275 300 325 380 o

The various tool sets available in Data Analysis View are shown on the
following pages. You can view a description of a button by moving the cursor
over it.

Agilent 6100 Series LC/MS System Quick Start Guide
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ChemStation Views

Common Tool Set This toolset is always present in Data Analysis view.

3[R

Graphics Tool Set Allows you to manipulate the graphic display.

L Ko e [=] [3) & wd = v = ]

=

g =1
=
m

0

Integration Tool Set Allows you to perform integration and reporting tasks on
a chromatogram.

(R ntegration]—> | [ i (1, QLAY IR

10 Agilent 6100 Series LC/MS System Quick Start Guide
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ChemStation Views

Calibration Tool Set Allows you to perform calibration tasks for quantitation.

' ﬁi} 5?’@ @ ,ﬁl M | Report:  Short -—E —-l :ﬁ &
ﬂé}tﬁ T  Owerview - Eth_\&ﬁﬁ

Signal Tool Set Allows you to work graphically with the UV or MS signal.

|l Signal| —> {H o Lo o ey i % Ry Y Ry el | ol [ ][]

Purify Tool Set Allows you to work graphically with your purification data.

[ilpuiy] —> (1] @] =8 [¢] [s]

Spectral Tool Set Allows you to perform spectral evaluation tasks.

[ spectum| = | &4 il il 1 g | osroorom B R
) [ [ [ ), 4 Ll

Deconvolution Tool Set Allows you to transforms mass spectra from
multiply-charged ions into a calculated molecular weight.

i e ||l

beh A
at] o5

&
oe
®

T
@
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ChemStation Views

Report Layout View

Report Template Calculation Technique

& Instrument 1 (offline 1): Report Layout
File Edit View Abort Help

; signals [ Lty oewot. 001
Re 3

New Section Menu

2 & a0 A 8 0 9 Toolbar

= CH\Chem3Z\1IMETHODS
L) BATCH.M ‘
) DEF_LCM

’Headnl
{1 DEMOCALL.M Footer

-{) DEMOCALZM | Footer

. . Report Section
Insertion Triangle i recacic: P

Click a blue triangle to activate o
the new section menu (triangle e

~{)) DECALOGQ4.M

turns red) 0 vecaLocs

-{) DECALOQE M v
Methods

Header

=f] Method and Run Control

13 Data Analysis
f Repork Layout

% verification (00/P¥)

Message Line

Ready | | Section Sizebar, drag to resize section, cick to select section,

Report Layout

Tool Set This toolset is present in the Report Layout view. Move the cursor
over a button to view a description of it.

NN IRz - o R

Tips < Edit or create a report layout as described in the online Help.

¢ To test your report layout, select a calculation technique from the
drop-down list box to define how the results are calculated.

* Load a data file. The results are loaded into the report template using the
selected calculation.

* Select File / Add to Report Styles to add your completed report template
to the list of available report styles. Now you can use your customized
report within a method.

12 Agilent 6100 Series LC/MS System Quick Start Guide
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ChemStation Views

Sample Report Layouts (in \CHEM32\REPSTYLE)

Template Description
SIMPLE.FRP Includes a chromatogram and calibration curves per calibrated
compounds.

NESTED.FRP Shows how to nest subsections.
SPECTRAFRP  Shows how to include spectra.

PURITY.FRP Shows how to include peak purity data. Print Preview button

ESTD.FRP Uses the same elements as the standard ESTD reports so you can
customize your external standard reports. —l

AREAPCTFRP  Uses the same elements as the standard area percent report so you can
customize your area percent reports.

@ Report M=l B3

Example of a simple Report Layout -
Data File name: C:\HPCHEMY 12 DATAWMEDEMOY, CAFCALOZ . D e
Method name: C: HPCHEM 1Z\METHODS CAFCALIE. M

To test this template load a
calibrated method

RBeplace the logo by inserting your company logo as
TMF graphic and insert your company name as a
constant text” here.

Aggilent Teeshn ol ngyins

The gensral section comprises slements that are walid for the complete data
file. The elements below were inserted using the text and number tools.

data acquired by: mcocintyre
oL 176,97
wial # Z.000
DAL & Sig=272,4 Raf=450,50 (W5 DEMOCAF CALDZ, O)
mAll 2
10000 £
7500 4 £
5000 ©
2500 -
0 - . . . e .
i i 1 15 8 i
WSO TIC, MG File (W5 DEMOWCAF CALDZ. 07
10000
7500 4
5000 2 Ll
HP Laser.let 45i MX on LPT1: Close | normal j Page of 2 Prewv | Next | Print | Help |
Letter & 1/2 %11 in/FPortrait

Agilent 6100 Series LC/MS System Quick Start Guide 13

Downloaded from www.Manualslib.com manuals search engine



http://www.manualslib.com/

ChemStation Views

Verification (0Q/PV) View

Start/Stop Run Verification Toolbar
4 LCMS Single Quad (online): Verification (OL/PV) fela =
File Instrument Verification Options  Sysfim Verification  View Abort Help
PO SEIBODR LS
Ready | ST I | (1) Method: SULFA MS SIM 1M | i Sequence: DEF_LC.S | EWF
=]
Ta S k Run System Verfication rs
Selection =] AA
Me“u Define System Yerffication QO (V] Idle [e]c] & Idle 00 (V] Idle eJo . ]
Xé iy fi a Port1->2 i % —i—
Remove System Yerification ¥ 1000 00 E ==
a1l i mL/min ® '
System . BB ‘I
Diagram =
Single Sample
- :mﬁm e ::':::p\e Name 2014-03-1 Sﬂ:i: z’ﬁf\ljﬂ:
"tﬂ Method and Run Control
], vata s
j Report Layout
@ Diagnosis
qﬁ MSD Tune
8 SYSTEM (localhost) T LCMS Single Quad (2 0 [ Reacy
Message
Line
The Verification (OQ/PV) view lets Agilent service engineers test whether your
analytical instruments and the ChemStation software are operating correctly
according to predefined performance criteria.
Operation Qualification (0Q) Operation Qualification is the documented
verification that the equipment-related system or subsystem performs as
intended throughout representative or anticipated operating ranges.
14 Agilent 6100 Series LC/MS System Quick Start Guide
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ChemStation Views

Performance Verification (PV) Performance Verification is the documented
verification that the process and or the total process-related system performs
as intended throughout all anticipated operating ranges.

System Diagram Each icon of the system diagram represents one component
or module of your system.

Verification Toolbar The Verification toolbar is displayed when you select
Show Top Toolbar from the View menu. Move the cursor over a button to view
a description of it.

B e S OO RS S

Available Tests The following verification tests are supplied with your
ChemStation software for use by an Agilent service engineer. Refer to the
online Help for more information on these tests.

¢ VWD Wavelength Accuracy

¢ Intensity

* Holmium

* Temperature Accuracy

¢ Noise, Flow, Temperature

* DAD Wavelength Accuracy

* Injector Precision

¢ Detector Linearity/Carry-over
¢ Injector Linearity

* Gradient Composition

Agilent 6100 Series LC/MS System Quick Start Guide 15

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

ChemStation Views

Diagnosis View

Symptoms Possible Causes Cause
I | Information Pad
Task 48 LCMS Single Quad (online): Diagnosis SULFA MS SIM 1M, no Sample Name 21)14-03-18'2-58—44.D, ATUNES.TUN I (=R Ecl =5
Selection Flle Diagnosis Maintenance View Abort Help
Menu Test Results/Logbooks |3 d | | 00/ Qbserved Symptoms  Low signal > Possible Causes Capillary needs maintenance -
| Memo Pad | Capillary needs maintenance
S
Tests... —
<— Capillary Current Plat
% Fragmentor
System On
Instrument System OFf
Panel
u MSD Generic Information
_________ Product Mo GE1304 Serial Mo, U5 3206850437
Fuw/ Rew. SmantCard 30248 MSD On Time 0.53h
% Llethadapd Bup. tanteal Manufacturing D ate 03/10/2005 |nstrument iButtan Show
LAN Address 92.168.254.12 Source iButton Show
= i Data Analysis
j Report Layout %
Copyto Mema Pad | | send Changes | | Caneel Changes |
% Yerification (0Q/P¥)
View =
. MSD Tune
Selection i)
»
£ SVSTEM (ocalhost) T LCMS Single Quad [ 0 L2 Ready

Message Line

Variables Display

This view allows you to carry out diagnostic and maintenance activities on
your system.

Diagnosis Toolbar The Diagnosis toolbar is displayed when you select Show
Top Toolbar from the View menu. Move the cursor over button to view a
description of it.

J| Test Resultz/Logbooks L.% | QAR .&nal_l,ltiu:| Obzerved Symptoms ﬂ Pozszible Cauzes ﬂ
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MSD Tune View

Title Bar MSD Tune Toolbar

[ instrument 1 (online): MSD Tune DEF_LC.M

. . Fle Tune MsData [nstrument Abort View Heip
Flle Se'ectlol‘l — {C\CHEM32\1) 1960DTUNATUNES. . 7 \_'% .J%‘ J@ Eﬁ %:_Q l'#g | 'lE‘u
sis i

I —

i Polarity Positive > Mode 1.API1ES ¥ Source API-ES

Calibrant  Off ¥ Sean  Standard v

ChemStation Views

Status Bar

=3

[+ C:\Chem32\1\DATA
& aFcDELAY
& oeFLC
&3 DEMO
&£ MSDEMO
i§ SingleRuns

Dats |Methads

% Method and Run Control

View Selection i

Lfﬂepnnuwm

% Verification (0Q/PV)

# o

MSD Tune

Message Line

Ready | |>>> Autotune register not found

MSD Tune Toolset

This toolset is present in MSD Tune view.

Load an LC/MS tune file.

[§!
= +l
Save the current tune file.
] ;4
LA l"ua
Generate a profile and scan =
ﬁj report. =
Autotune the LC/MS and print a
T
iy tune report. [.__qu

Agilent 6100 Series LC/MS System Quick Start Guide
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parameters.

Edit LC/MS parameters for
manual tuning.

Acquire multiple scans and send
results to data file.
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Basic Operation

Basic Operation

Start up and shut down the system

Task Instruction

Comment

To start up the system 1 From the Method and Run Control
view, click the () button on the
system status bar. When you move
mouse over the button, if system is
currently idle, it turns green.

2 Set up the LC conditions (pump,
column heater, and detector).

3 Set up the LC/MS spray chamber
conditions as described in the MSD
Spray Chamber dialog box topic in
the online Help.

Allow 15 minutes for the system to warm

up.

To put the system in Standby Mode 1 Flush the system with pure mobile
phase to ensure that the flow path is
clear of buffers. This prevents the
nebulizer from plugging. A plugged
nebulizer can cause a high back
pressure, which can damage the LC
flow cell.

It is good practice to flush the flow
path (including the column) for 5 to 10
minutes with a mobile phase without
buffers such as 50:50
water/acetonitrile.

2 Click the () button on the system
status bar. All modules are set to
standby mode (indicated by the gray
color in the system diagram).

This procedure assumes that the
system is under vacuum and the LC
and LC/MS are properly connected. It
also assumes that the liquid flow path
is properly set up.

Put the system in standby mode
overnight or whenever you are not
analyzing samples for an extended
time. The standby state for the LC/MS
leaves the nebulizer and drying gas on
at low flow.

Standby for the LC/MS is:

» 20 psi for the nebulizer,

* 3 L/min for drying gas,

» 300 °C for drying gas temperature,

» 325 °C for the APCI vaporizer, if
present

+ the MS stream selection valve is
set LC to Waste.

For Agilent Jet Stream source:

« Sheath temp 100°C
» Sheath gas flow 2.2 L/minute

18 Agilent 6100 Series LC/MS System Quick Start Guide
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Basic Operation

Tune the LC/MS

When the LC/MS is used as a detector for the LC, a mass spectrum is
associated with each data point in the LC chromatogram. To obtain high
quality, accurate mass spectra, optimize the LC/MS to:

e Maximize sensitivity
¢ Maintain acceptable resolution

¢ Ensure accurate mass assignment

Tuning is the process of adjusting LC/MS parameters to achieve these goals.
After the LC/MS parameters have been optimized, they must be saved in a
tune file (.tun). This tune file is then specified in the method that is used to
acquire data for your samples.

Frequent tuning, whether automated or manual, is not required. Once tuned,
the LC/MS is stable. Tuning is needed no more often than monthly, weekly at
most.

Wait 4 hours after pumpdown before tuning or operating your LC/MS. The
analyzer takes about 11 hours to reach thermal equilibrium. Tune files that
are created or data that is acquired before the LC/MS is at thermal
equilibrium can have incorrect mass assignments and other inaccuracies.

Task Instructions Comments

To use Autotune 1 From the MSD Tune view, select Use autotune for automated
Autotune from the Tune menu or click adjustment of the LC/MS
the Autotune toolbar button. performance.

2 Review the tune report that is printed
automatically when tuning is
completed.

Agilent 6100 Series LC/MS System Quick Start Guide 19
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Basic Operation

Task

Instructions

Comments

To use Check Tune

To use Manual Tune

1 Select Check Tune from the Tune
menu.

2 Review the Check Tune report.
Adjustments are suggested for values
that are outside of acceptable ranges.

1 Select Manual Tune from the Tune
menu.

2 Set the desired mass resolution
(adjusting width gain and width
offset).

3 Calibrate the mass axis (adjusting
mass gain and mass offset).

4 Qptimize the ion transmission through
the source ion optics (fragmentor,
skimmer(s), lens 1, lens 2, and
octopole peak).

b Adjust the signal strength (setting iris
and adjusting the multiplier gain).

Fragmentor and gain are method
parameters. The fragmentor affects ion
transmission and fragmentation. For
more information, see the online Help.

Use Check Tune to determine quickly
whether the LC/MS is correctly tuned.
It performs a single profile scan of the
tune masses and compares the peak
widths and mass axes with target
values.

Use Manual Tune when you want to:

* Achieve maximum sensitivity by
sacrificing some resolution

« Tune specifically for the very low
end (<150 amu) of the mass range

* Tune with a compound other than
the standard calibrants

20
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Basic Operation

Acquire LC/MS Data

Modes of Acquisition

There are three modes of acquiring data:
* Running a method for a single sample
¢ Running a sequence for multiple samples

¢ Running an FIA series
Note the following about acquiring data:
¢ All three acquisition modes require an appropriate method.

* Samples can be injected either manually or with an ALS.

¢ Always start a run from the software.

¢ An FIA method cannot be used in a sequence but multiple FIA methods can
be run sequentially.

Agilent 6100 Series LC/MS System Quick Start Guide 21
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Basic Operation

22

To edit a method and start a run

Once you know the acquisition mode that you want to use, you must set up an
appropriate method. Methods are set up in the Method and Run Control view.

Instructions

Comments

1 Activate the single sample toolset by clicking the
[@] button on the toolbar.

2 Load a method by selecting Method / Load Method
or by clicking the [ button on the toolbar and
selecting a method from the list.

3 Click the p«f button to begin editing the method. You

can also begin by selecting Edit Entire Method from
the Method menu or by right-clicking the m icon
on the Run Control Bar.

4 Select the method sections you want to edit (select all

sections to become familiar with the method
parameters that are available) and click OK.

5 Add any method comments you want to appear on
your reports.

6 Set up the instrument parameters, such as pump,
injector, DAD or VWD, column thermostat, MS
signals, and MS spray chamber.

7 Set up the Data Analysis parameters, such as signal
details, integration events, report parameters,
instrument curves, calibration curves, calibration
table, and ion parameters.

8 Complete the Run Time Checklist.

9 Save the method using a different name. Select

Method / Save Method As or click the g, button on

the toolbar.

10 When you are ready to begin a run, click the Start
button.

A series of dialog boxes is displayed,
which allows you to set up your
method and instrument parameters.

Click the Help button on any of the
method dialog boxes for descriptive
information on the items available in
each.

Once you are familiar with the options
that are available, use the system
diagram menus for quick access to
particular method parameters.
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Deconvolution

Deconvolution

Deconvolution is an optional process (additional license required) that
transforms mass spectra from multiply-charged ions into a calculated
molecular weight.

To deconvolute a mass spectrum

Instructions Comments
1 In the Data Analysis view, load an electrospray MS
data file. The TIC is displayed.
2 Generate the MS spectrum that you want to These operations are performed on
deconvolute. (Select the Spectral task tool set and use  data acquired in full scan mode.
the spectrum selection tools to pick the spectrum of
interest).
3 Click the Enter Deconvolution Tool button to =
set up the deconvolution display area. _.LLLLI
4 When the spectrum is displayed, click the
Label lons button to locate masses to be o
used in deconvolution.
b Examine the ions that were found. Very noisy data or  You can use the lon Label
data with unresolved regions often need special Options button to optimize ﬂfﬂ
settings to find ions. the set of ions found.
6 Click the Edit Deconvolution Parameters Al
button to change any of the parameters.
“AR
7 Click the Run Deconvolution button to begin Al Once the deconvolution is done, the
the deconvolution process. l“‘}_ﬂ,_ components are displayed in the
upper right window. The charge states
are displayed in the lower right
window.
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Deconvolution

Instructions Comments

8 Select specific components from the Component list ~ Optionally, click the Preview 5
to look at individual components or groups of Deconvolution Report
components. button

or click the Print Report
button. {@

9 Optionally, select components from the This action removes the peaks for the
Component List box and then click the lﬂl selected components from the original
Delete Components button. spectrum. You can then continue with

10 Repeat the process. step 4 (previous), using this new
spectrum.

Deconvolution Report

The Deconvolution report contains summary information about each
component selected, along with detailed information on how each peak in a
component contributes to the molecular weight of the component. In the first
part of the report, the components are ranked by percent relative abundance,
which is useful for estimating the percent of impurities.

The actual molecular weight can differ from the computed molecular weight
even if the data fit a Gaussian curve perfectly, due to other errors such as
errors in mass axis assignment or unresolved chemical impurities.

The Deconvolution software is optional and is part of the OpenLAB CDS
ChemStation C.01.xx or M8363AA (ChemStation C.0x) Bioanalysis Software
package.
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Operating Tips

¢ Back up your data and methods regularly to avoid loss of data in case the
files are accidentally overwritten, deleted, or if a hardware problem
develops with your disk drive.

¢ Put the system in standby mode overnight or whenever you are analyzing
samples for an extended time.

¢ Verify that the tune file you are using is appropriate for your samples.
e Save Tune reports in an MS Logbook for future reference.

¢ Regular system maintenance can reduce problems. Keep a maintenance
record.

* Use the Maintenance Logbook and EMF features in Diagnosis view to help
you track when maintenance is needed and to keep an online maintenance
record.

¢ Flush the sample path and clean the spray chamber, capillary tip, and spray
shield daily or at the end of each shift. Check the foreline pump fluid level
every week.

¢ The spray chamber vent hose must be connected to a lab vent that is used
only for the source. The vent hose must be separate from the vent hose for
the foreline pump. Otherwise, waste products can migrate into the spray
chamber vent producing chemical noise.

¢ Samples must be filtered. If no chromatography is used, they must be salt
and detergent-free.

e Ifa UV detector is available, use it in series with the LC/MS. Try to
minimize chromatographic peak broadening by using low dispersion tubing.

¢ To avoid chromatographic band broadening, be sure that all tubing
connections are free of dead volume. Use zero dead-volume (ZDV) fittings
when possible.

¢ Use the following table as a guide to using SIM, condensed scan, and full
scan acquisition modes.

Task Mode

Acquire electrospray data for samples containing large, Full Scan
multiply-charged analytes.

Analyze a mixture with unknown components (small molecules). Scan
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Task Mode
Analyze a mixture with known components in unknown amounts Scan or SIM
(quantitate).

Identify the presence of a few known compounds at low levels SIM

within a mixture.

Use fast chromatography on 1.0-MHz LC/MS systems (G6120B, Fast Scan
G6130B) without missing peaks.

Use fast chromatography on 1.4-MHz LC/MS systems (G6150B) Ultra Fast Scan
without missing peaks.
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Troubleshooting Tips

Troubleshooting Tips

No peaks
v/ Verify that there is spray from the nebulizer.
v/ Verify that the capillary voltage is set correctly.

v/ In APCI mode, verify that the corona needle is installed.

In APCI mode, verify that the Corona Current setting is 2 uA or higher, and
that the Corona Voltage is between 1500 and 5000 V.

v/ Verify that the MS system is tuned correctly.

v/ Verify that MS vacuum pressures are within normal ranges.

v/ Check the drying gas flow and temperature.

v/ Verify that the fragmentor is set correctly.

v/ Check if any error message indicates a problem with electronics.

v/ Verify that sufficient sample is present in vial.

Poor mass accuracy

v/ Recalibrate the mass axis.

v/ Verify that the ions used for tuning span the mass range of the sample ions
and that they show strong, stable signals.

Low signal

v/ Check the solution chemistry. Verify that the solvent you are using is
appropriate for your sample. Mixed samples can exhibit signal suppression
of one or more components.

v/ Verify that the sample is fresh and has been stored correctly.
v/ Verify that the MS system is tuned correctly.

¢/ Check the nebulizer condition.

v/ Clean the capillary entrance.

¢/ Check the capillary for damage and contamination.
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v/ Verify that the spray chamber parameters are set correctly, such as drying
gas heater and nebulizer pressure.
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Troubleshooting Tips

Unstable signal

v/ Verify that the drying gas flow and temperature are correct for the solvent
flow you are using.

v/ Verify that the solvent is thoroughly degassed. Do not use ultrasonic
degassing with protein samples.

v/ Verify that the LC backpressure is steady; steady backpressure indicates a
steady solvent flow.

High spectral noise

v/ Use appropriate mass filter values.

v/ Check the spray shape. Nebulizer can be damaged or incorrectly set.

v/ Verify that drying gas flow and temperature are correct for the solvent flow
you are using.

v/ Verify that the solvent is thoroughly degassed. Do not use ultrasonic
degassing with protein samples.

v/ Verify that the LC backpressure is steady; steady backpressure indicates a
steady solvent flow.

v If you are using water as part of the mobile phase, verify that it is deionized
(>18MQ).
Droplets, not spray, exiting the nebulizer

v’ Verify that the nebulizing gas pressure is set high enough for the LC flow
being used.

¢/ Check the position of the needle in the nebulizer.

v/ Stop the solvent flow and remove the nebulizer assembly. Use a magnifying
glass to examine the end of the nebulizer for damage.
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No flow

v/ Verify that the LC pump is on and there is sufficient solvent in the correct
bottle.

v/ Verify that the solvent supply lines are free of air bubbles. Purge the
appropriate pump channels, if needed.

v/ Check for LC error messages.

v/ Check for blockages. Repair or replace any blocked components.
v Check for leaks.

v/ Verify that the MS stream selector valve is set to LC to MSD.

Undesired fragmentation
v/ Fragmentor is set too high.
¢’ Tonization is causing fragmentation (APCI vs. Electrospray).

v/ APCI temperature is too high.
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Safety Warnings

Intended Purpose

Use of the LC/MS in a manner not intended by the manufacturer is prohibited.

Safety Class

The LC/MS is a Safety Class 1 instrument. It has been designed and tested in
accordance with IEC Publication 1010-1, Safety Requirements for Electrical
Equipment for Measurement, Control, and Laboratory Use.

Stack Configuration

m Do not stack more than three LC modules of any kind on top of the LC/MS
instrument. Stacking more than three LC modules is potentially unstable and
dangerous.

Placing the LC modules on top of the LC/MS is also inconvenient. It puts the
solvent bottles and some LC controls out of easy reach and requires the LC
stack to be disassembled and removed for LC/MS maintenance.

m Use only Nitrogen as the drying and nebulizer gas. Air, oxygen, or other gases,
when combined with solvents and high voltages in the spray chamber, can result in

an explosion.

m Do not connect the LC/MS to a power source that is not equipped with a protective
earth contact. You can create a shock hazard for the operator and can damage the
instrument.

m Do not interrupt the protective conductor inside or outside the LC/MS or disconnect
the protective earth terminal. You can create a shock hazard for the operator and
can damage the instrument.
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m Do not adjust, maintain, or repair the opened instrument while it is connected to a
power source. Only trained persons who are aware of the hazards involved can
perform these operations.

m Before you perform maintenance on the electronics vent and turn off the LC/MS
and disconnect the power cord. The power switch on the front of the LC/MS does
not completely cut power to the instrument.
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